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What is Bluebeam? 

Bluebeam is a cloud-based external collaborative tool that allows both MassDOT and external 
consultants the ability to manage, comment and share updates to documents and drawings in 
real-time during the 25%, 75%, 100% and PS&E review phases. This process allows reviewers to 
follow the changes to the documents and drawings and expedites the review time, as it is all 
captured electronically. Bluebeam eliminates the need to generate response to comment 
forms in Word or Excel and distribute them to the PM. 

The Bluebeam session can be easily accessed through an invitation link from the session 
creator, the Project Manager. Users also have the option to access a session using the session 
number. 

Per Engineering Directive E-18-002, Bluebeam Revu is the platform that shall be used for all 

phases of projects in the project delivery program. The current version of Bluebeam is 

Bluebeam 2020.  This guide, including tutorial information, shall be based on that version. 

Depending on the nature of the review - design, construction, design-build - there are different 
ways that the digital review process is built into the project delivery schedule. This is illustrated 
in the following flow charts: 
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Bluebeam Process Charts 
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Bluebeam Functional Area/Activities and Roles 

Bluebeam Functional Area/Activities and Roles 

Functional Area/Activities 

Roles 

PM Co-Host Reviewer 
Supervisory 

Review 
Designer 
of Record 

Creates Session Y N N N N 

Ability to Comment on Documents 
via Bluebeam invite 

Y Y Y Y Y 

Ability to Add Additional 
Reviewers to the Session 

Y Y N N N 

Ability to Open and Close Session Y Y N N N 

Business Roles and Definitions 

Project Manager – Project Manager assigned in Project Info for a specific Project. Responsible 

for the management of Submittal Reviews utilizing Bluebeam. 

Co-Host – Ability to add additional Reviewers to the session.  Ability to act as PM in full capacity 

if PM is unavailable. 

MassDOT Reviewers – MassDOT technical subject matter experts who have been identified by 

discipline. 

Designer of Record – Selected Designer of Record (DOR), either in-house MassDOT designer, or 

a consultant hired for a specific project. 

Supervisor Review – Reviewer’s supervisor. When a Reviewer sets status to “Pending 
Supervisor Review”, Supervisor will review sessions and recommend modifications or approval 

for the Reviewer to implement. 

October 2022 MANAGING BLUEBEAM| NKC 8 



 

      

 
 

  

        

        

          

    

 

         
         

           
   

 

 

  
 

          
         

      
 

          
  

 

 
 

 

 

 

-

General Guidance 

What are studio sessions? 

Sessions enable document-based online collaboration. They are accessible through the Revu 

interface. Only the host needs a Revu license to initiate a Studio Session, and all invited 

attendees can participate in the Session through Revu, Revu for iPad or even our free PDF 

viewer, Bluebeam Vu for Windows and iPad. 

Each session is unique to a specific submission within a project. 
Project Info – Project Info entries and responsibilities are still mandated and required. 
All Project Info updates must include the session start date under “Package Distributed”, and 
review time frame. 

Changing Author Settings 

Please follow the steps below to change your author settings within Bluebeam (will take effect 
in new BB sessions). Please use the [District or HQ Section] [First Name] [Last Name] format; 
Example: D1 John Smith, HQ Traffic Jane Smith. 

This will help the PM and the Designer know who the review comment is coming from and will 
also help organize the CRM. 

Click Manage 

Servers 

Click the Signed in as: down arrow. 

Click Studio 
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Click Servers 

Click Studio 

Edit Display Name 

Click OK 

• It is especially important to initiate your session by confirming you are connected. It is 

recommended never to work “Offline” 

A red dot in the Connection 

Icon means Working off 

line Disconnected” Bourne Test 929 401 531 
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A green dot in the Connection Icon means 

Working on line Connected 

Bourne Test 929 401 531 

• All “General Comments” should be posted on the first page of the document set. 

• Consultant evaluation scores shall be provided by the reviewers. The Project Manager 

is responsible for including the data entry form from SOP 810 Attachment E for 

reviewers to fill in scores at each design stage (25%, 75%, 100%). 

• Only the creator of the comment(s) has the ability to delete the comment or 

information. 

• It is critical to only use objective language when writing a comment or replying to one. 
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Setting-up Your User Interface 

In Revu, tools and data are organized in panels that appear in specialized pull-outs found at the 

left, right, and bottom of the application. The two panels most frequently used are the Studio 

panel and the Markups panel. 

Whether a particular panel is visible in the workspace or not is customizable. To show or 

hide panels, go to Window > Panels and select the desired panel: highlighted panels appear in 

the interface and the others are hidden. 

Window 

Panels list 

Panels 

Bourne Test 929 401 531 
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The Studio panel can 

be enabled/disabled 

by clicking the Studio 

button 
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Session Status 

Setting this session status is an important step in Bluebeam. The purpose of setting status will 

be used by the PM and other users to identify participation in the session and notify when 

complete. 

Each Reviewer is responsible for setting their respective Status. 

1. Reviewing 

2. Waiting 

3. Finished 

Once the session is opened, Reviewer is required to set the status to “Reviewing”. Upon 

completion of the review and prior to the review due date timeline, the reviewer is required to 

set the status to “finished”. 

Status Definitions 

1. Reviewing: Reviewer is currently reviewing documents during defined review timeline. 

2. Waiting: Reviewer has reached out to other Reviewers and is waiting for feedback or 

waiting for supervisor approval. 

3. Finished: Review is complete – Review status “Finished”. 

Session review statuses 

Bourne Test2 898 617 633 
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Designer of Record Role 

General 
The designer of record (consultant or in-house) is responsible for assembling and organizing 

documents for each of the scheduled phases. In addition, the designer is responsible for 

ensuring that all comments have been addressed, including documenting, and tracking 

comments that are not addressed through the comment resolution meeting. 

Design Submission 
All files to be reviewed shall be submitted to the MassDOT PM in .pdf format.  All other file 
types shall be submitted as required by MassDOT. 

Files to be reviewed shall be named with the following prefixes. The file name after the prefix 
can be determined by the Consultant. For example, 001_XXXXXX_Bridge B-01-001 Sketch Plans 

Naming convention prefix: 

• 000 – Table of contents 

• 001 – Plan submittals 

• 002 – Utilities 

• 003 – ROW 

• 004 – Environmental 

• 005 – Reports 

• 006 – Specifications 

• 007 – Estimate 

• 008 – Schedules 

• 009 – Other 

Provide a Table of Contents with the submission which describes all the files provided in the 
submission. 

When plotting AutoCAD drawings to .pdf, prior to plotting, set EPDFSHX to 0 within AutoCAD. 

All other PDF files shall be “flattened” prior to submitting. Certified PDF files will not be 
accepted. 

Highway plan sets shall consist of a single volume and be submitted as a single PDF. 
Color utility plans shall be included within the highway plan set in lieu of black and white 
plans. 
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Designer Response to Comments 

After the review is complete the MassDOT PM will invite the designer (in-house or consultant) 
to the review session to respond to comments. While comments are being responded to, only 
the designer and the MassDOT PM will have access to the review session. Access to the session 
for the MassDOT reviewers will be denied once review comments are finalized. 

The designer will respond to comments by setting a status to the comment within Bluebeam 
and providing a written response to the comment within Bluebeam. The available statuses are: 
Accepted, Rejected, Cancelled, Completed, and None. 

1. To set the status of the comment, click on the comment in the comment log, and from the 
Status pull down at the top of the comment log, set the status of the comment. 

Figure 1 Set Comment Status 

Click on the comment 

Click the Status pull down 

Select Status 

2. To provide a written response to the comment, right-click on the comment, and then select 
Reply.  Provide a written response in the text box. 

Figure 2a Reply to Comment 

Click on the comment 

Click Reply 

Figure 2b Reply to Comment 
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Begin typing your comment 

on the provided text box 

3. When the comment has been responded to, the response will appear below the comment 
in the comment log. 

Figure 3 Completed Comment 

Your reply to the comment will appear 

on the comment panel as shown below 

After all comments have been responded to, the designer will coordinate with MassDOT PM to 
set up a Comment Resolution Meeting (CRM).  During the CRM, Bluebeam will be utilized to 
review comments/responses as needed. Note that comments may be sorted by Subject, Page 
Label, Comments, Author, Date, Status, etc.  After comments/responses have been resolved, 
the Consultant will modify any responses as needed and then notify MassDOT PM when 
completed. 
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Project Manager Role 
Getting started 

OVERVIEW OF BLUEBEAM FOR REVIEWERS 
Per Engineering Directive E-18-002, Bluebeam Revu is the platform that shall be used for all 

phases of projects in the project delivery program. 

The current version of Bluebeam is Bluebeam 2020.  This guide, including tutorial information, 

shall be based on that version. 

Training: Periodic introductory training is available. Section supervisors shall be responsible for 

ensuring that reviewers are adequately trained. 

SUBMITTAL DOCUMENTS 

- Per the Design Schedule, the Designer will submit Submittal Documents for review using 

the defined File Template 

Naming convention prefix: 

• 000 – Table of Contents 

• 001 – Plan Submittals 

• 002 – Utilities 

• 003 – ROW 

• 004 – Environmental 

• 005 – Reports 

• 006 – Specifications 

• 007 – Estimate 

• 008 – Schedules 

• 009 – Other 

- The Project Manager is responsible for including the data entry form from SOP 810 
Attachment E for reviewers to fill in scores at each design stage (25%, 75%, 100%). 
“See Appendix A-D” 

- Must be part of a single review session 
- The PM is responsible for ensuring the Designer adheres to the directed file naming 

convention 

- The PMs will fully utilize the Design Project Checklist in PDGG to align with the Submittal 
Review for the Project 

- The PM will be responsible for ensuring the Distribution list follows the SOP 

- The PM will be responsible for inviting their Co-Host (contact your supervisor for 
assigned Co-Host). 
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- The PM will be responsible for inviting DOTBluebeamSupport@dot.state.ma.us as Co-
Host 

- The PM will be responsible for managing and maintaining access for the 
internal MassDOT Reviewers and the External Consultant Reviewers via the “Allow/Deny 
Process” 

- The PM will be responsible for setting the expiration date in Bluebeam 
- Recommended language for the “Add Message” 

[Project Number [TOWN/Municipality]- [DESCRIPTION FROM PINFO] 

Design Stage: XX% Submission 

Review Comments due: MM/DD/YY 

Advertising Date: MM/DD/YY 

Designer: XXXXXXXX 

Co-Hosts: MASSDOT CO-HOST, DOTBluebeamsupport 

Link to submission: PROJECTINFO LINK 

- The PM will be responsible for reviewing all responses and coordinating any conflicts 

- The PM will be responsible for managing and facilitating Comment Resolution Meetings 

- Recommended tools for online meeting/conference tools: 

• Conference room meeting with computer and smartboard 

• Virtual Meetings 

- The PM ensures the designer has finalized RTCs following the Comment Resolution 
Meeting 

- The PM will Finalize Sessions 

- The PM will be responsible for updating ProjectInfo and updating the ProjectInfo File 

Repository with the reviewed PDF documents 

- The PM records dates in Tasks and Events in ProjectInfo 

- All review sessions shall end at 11pm 

- Consider adding any reviewers who previously reviewed prior submissions 
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Creating a Session 
To begin creating your new session, select “New Session” [NOTE: DO NOT create a "New 

Project"]. 

Select the Sessions button 

Click the plus (+) sign and 

select New Sessions 

1. Name your session.  Sessions must be named with the Project Number + 

Town/Municipality and Submission description; click “OK”. Example: 

606060_Town/Municipality_25% Review 

Enter Session Name 

Select required 

options 

Set session expiration date 
Click OK 

All files should be added prior to sending session invites.  This will allow the PM to make 

sure files are acceptable (named correctly, flat, not certified). 
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2. The “Session Invitation” screen will pop-up.  Project Manager will need to refer to 

the Reviewer Distribution Lists in the SOPs. 

Click the Invite button 

to add attendees. 

Click on Type or Paste 

Emails 

Bourne Test 929 401 531 
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  Enter email addresses or copy and paste from a list 

Type 
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+ Add Emails options 

Click Invite Participants 

to complete 

E mail list will 

display here 
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Invitations sent 

Click OK 

Recommended language for the 
“Add Message” 

[Project Number [TOWN/Municipality]- [DESCRIPTION 

FROM PINFO] 

Design Stage: XX% Submission 

Review Comments due: MM/DD/YY 

Advertising Date: MM/DD/YY 

Designer: XXXXXXXX 

Co-Hosts: MASSDOT CO-HOST, DOTBluebeamsupport 

Link to submission: PROJECTINFO LINK 
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Add Emails from 

Groups option (Co 

Hosts, Co chairs, 

Reviewers) 

Add e mails from 

created groups 

(Co Hosts, Co 

chairs, Reviewers) 
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The Use Address Book 

option is disabled 

3. To delete an email address, click on the email address you wish to delete and click 

the “delete” button or click the email address and then click remove. 

To delete an e mail, 

click on the e mail you 

wish to delete and click 

the trash (delete) icon. 
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To delete an e mail, 

click on the e mail you 

wish to delete and click 

the remove button. 

Helpful hints: 

• You don’t need to initiate another session to add reviewers. 
• You don’t need to initiate another session to add documents. 
• Documents can always be added or removed. 

• Reviewers can only be added, but not removed. 
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Setting A Bluebeam Session Co-Host 

A Co-host is a person assigned by the PM and will have the ability to Add or Deny invitees. In 

rare cases, and only at the direction of their manager would they take full control of the 

session, due to long term absence or critical issues. 

Only the Bluebeam Support Co-Host will have the ability to allow or deny an additional invitee 

at the direction of the Manager. 

A. To edit attendees access, click the “Attendee Access” icon next to the “Attendees” row. 

B. Click on the “Attendees” tab to add your co-host 

C. Enter the Co-Host email address. 

1. Click on the plus button ( ) to add co-host’s email address 

2. Enter your invitee’s email address 

3. Click OK. 

4. Repeat steps above to add DOTBluebeamSupport@dot.state.ma.us 

Click the Invite button 

to add co host. 
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Click on Type or 

Paste Emails 

Enter co host 

email address 
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Manage Attendee Access 

Following the review period, the PM will manage attendee access to the studio session, by 

denying access to Reviewers and inviting the Design Engineers. 

To access the permissions, click 

on the Session Settings button. 

Select the Permissions tab 
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Managing access at the Attendees tab: 

Click on the e mail 

Click OK 

Change permission 

Managing access at the Permissions tab: 

Manage permissions for specific 

actions or full control 
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Manage permissions 

• Follow invitation instructions to invite Design Consultant. 

• Design Consultant conducts their response to comments. 

After attendees are locked out, add the Design Consultant using the same invitation method: 

Attendee access column shows 

allowance for the Design Consultant 

while MassDOT is locked out. 

Helpful hint: 

• You don’t need to initiate another session to add reviewers. 
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Finishing and saving a Bluebeam Studio Session 

Create the folder in Pinfo that the session will be saved to. Ensure the folder name reflects 
Submission + Date (25% 5-1-2019).  Example: Within the design submission folder in ProjectInfo 
would be folders “00_Original Submission”, “01_Review Comments”, “02_RTCs”, “03_Finals”. 
All reviewed documents must be saved in ProjectInfo. 

Best practice would be to save files four times thru the session lifecycle: 

1. Originals received from designer. 
2. Reviewers made their comments. 
3. Designer responded to comments. 
4. Designer updated responses after CRM. 

Once the Bluebeam session is complete, you need to “Finish” the session. Begin by closing all 
the session documents then click the “Finish” button. Continue to follow the steps below to 
complete the process. 

Once all session documents have been 

closed, click the Finish  button. 

The “Finish Session” pop-up window will display. 
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”

“

Please ensure Generate 
Report  is checked 

Select the Save In Folder” 
path by clicking on ellipsis 

button. 

Click OK; the session will 
be saved in folder selected. 
(Bluebeam session is now 
over) 

October 2022 MANAGING BLUEBEAM| NKC 34 



 

      

        
 

 

           
 

     
 

          
 

 
 
 

 
 

  

 

 
 

  

It is imperative you close the session when complete. Leaving your session open will cause the 
following: 

• After 80 days, a notification email is sent to the Host saying the Session will be archived. 

• After 90 days, the Session will be archived. 

• After 170 days, the Host will receive another email stating that the Session will be 
deleted. 

CRITICAL INFORMATION: 
AFTER 180 DAYS, THE SESSION WILL BE 

DELETED PERMANENTLY. 
IT CANNOT BE RECOVERED!!! 

ALL FILES MUST BE SAVED TO PINFO 
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Creating Comment Resolution Document 

1. Open your session 
2. Open your file(s) with review comments/responses within the session 
3. Click Batch→Summary 

Click the Batch menu 

Click Summary 

4. Click the Add pulldown button and click Add Open Files 
5. Click Next 
6. Uncheck all and recheck and reorder with the following columns – File Name -> Author -

>Page Label -> Status -> Comments 
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7. Sort the information that appears on the report, choose one or more sort options, 
starting with Sort by. All remaining options will be labeled Then by. 

Check/uncheck all by clicking the checkbox 

8. Sort by Author (Ascending), then by File Name (Ascending), then by Page Index 
(Ascending) 

9. Select PDF as the desired format for the summary report from the Export as menu 
10. Select Open File After Creation 
11. Confirm that the location in the Export to field is acceptable. To change it, click Change 

and select the desired location. It is recommended that you save the file directly to the 
appropriate folder in ProjectInfo. 
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1. Change the Title to Project Number, Municipality, Response to Comments. The name 
of the summary file will be based on this information. 

2. Confirm under PDF Options that the style is Table, and the Thumbnail is Large. 
3. Before moving on, you can save the entire configuration and set of options to use on 

future projects or future submissions of the same project. To do so, simply click Save 
Config and save to the same location as your Export To field. 

4. Click OK. The report is generated. This may take some time. 
5. Save a copy of the report to the Bluebeam session. If you did not export to ProjectInfo 

in Step 10, save a copy of the report to ProjectInfo in the appropriate folder format 
and naming convention. 
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Example Output: 

To link Markup Thumbnails with the actual comments, follow the steps below: 
1. Save each PDF individually 
2. Make sure “absolute hyperlinks” checkbox in the Options is checked. 
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Overview of Bluebeam for Reviewers 

Per Engineering Directive E-18-002, Bluebeam Revu is the platform that shall be used for all 

phases of projects in the project delivery program. 

The current version of Bluebeam is Bluebeam 2020. This guide, including tutorial information, 

shall be based on that version. 

Training: Periodic introductory training is available. Section supervisors shall be responsible for 

ensuring that reviewers are adequately trained. 

Procuring access to Bluebeam 

1. Users must request Bluebeam Revu via MassDOT Help Desk Ticket e-mail: 
MassDOT/MBTA - Login - MyMassDOT (service-now.com) 

2. User must create a Bluebeam account 

Select the Create 

Account tab. 
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“ ”

Please use the [District or HQ Section] [First Name] [Last Name] format; Example: D1 John 

Smith, HQ Traffic Jane Smith 

Please make sure to use 
your MassDOT email 
that includes the dot 
extension. 

Click Create Account 

Managing your Account 
Please beware, the e-mail address you provide for the Bluebeam account must be a MassDOT 

email address. E-mail address must include “@dot.state.ma.us” in order for your account to 
work properly. At this time, please create your username. 
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Review Session Setup 
Reviewer will receive e-mail invitation (invite) to join the review process. To open the session 

and join the review process, simply click on the Session ID No. and you will be directed to the 

Bluebeam session. 

To join the review 

session, click on the 

Session ID No. 

Or click Join Session 
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Firewalls and web security may ask for confirmation when trying to open the Bluebeam session. 

MassDOT reviewers may have to confirm the prompts shown below.  Please click “Allow” on 

both prompts to open the session. 

Click Allow 

Click Allow 

In some cases, users may have to copy and paste the Bluebeam Session ID included in the 

invite. 
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Managing Email Notifications Preferences 

1. Click the “Session Settings” button 

Click the Sessions  

Settings button 

2. Under Session Settings, General tab, click on the Manage Notifications link. 

Click the Manage 

Notifications hyperlink 
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3. The Studio Notifications Preferences form will display as shown below.  Select your 

account preferences 

Enable Notifications 

for this session 

Manage Account 

Preferences 

4. Click “Apply” 
5. Click the +Manage other Projects and Sessions link for more 
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If you’d like to receive/stop receiving notifications for other Projects or Sessions you’ve 
previously logged into, make all appropriate selections under the Sessions and Projects 

Subscriptions. 

6. Click “Apply” to save your changes. 

Alternatively, users can create rules in MS Outlook to manage emails from Bluebeam. 

Please note: Users will still receive emails for “Session Invite” and “Session Ended”. If the Host 
makes any changes to the date/time field of the session expiration, users will also be notified 

through email regardless of any preferences changes. 
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MassDOT Recommended Markup Tools 

The MassDOT markup tools typically used are the following: 

• Text Box 

• Callout 

• Cloud+ 

• Measure Tool 

Note: When marking up submittal documents, reviewers should take care that markings and 

comments are clear and concise and do not obscure document content or other comments. 

Markup menu 

Tools 

Markup 

Use of tools other than those listed above, are not recommended because they don't translate well in 

the markup summary. 
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Common Text Menu commands: 

Textbox 

Highlight 

Pen 

Cloud+ 

Cloud 

Callout 

Stamp 

Image 

Snapshot 

Callout note: If you add a “callout”, after you create it, you can right-click and add “leaders” 

rather than arrows and lines. 

Right click on callout 

Add/Delete Leader 
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Cloud+ note: You cannot add more than one leader using Cloud+ 

 

      

 

 

 

          

  

  

The Cloud+ command will allow you to create a cloud shape anywhere 

on the drawing/PDF along with a text box to add comments. 
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Other Useful Bluebeam Tools 

Grouping Shapes and Textbox 
To create your own box and add a callout comment, utilize the line and text commands in the 

Markup toolbar. Once completed, select every line and text box and right click on top of the 

selected shapes, then select “Group” 

Markup tools to create your 

own shapes and callouts 

Note: After grouping objects, add a description of the group. Do this by right clicking on the 

group comment in the markups list and type a comment in the description. 
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Adding Images and Documents 

To add images to the document in review, select the “Tools” menu and click the Markup, then 
Image, and select from the list of options. 

Tools > Markup > Image 

Select source 
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Attaching Documents 
Click Tools 

File Attachment 

Click Open 

Choose your file 
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-

Attachments will show 

as a paper clip; click 

anywhere on the 

document to place the 

attachment.  Top open 

the attachment, double 

click the paper clip. 

Note: After attaching a document, add a description of the attachment. Do this by right clicking 

the paper clip or adding the description in the comment field. 

October 2022 MANAGING BLUEBEAM| NKC 53 



 

      

  
        

 

 

 

 

 

 

 

Sorting by Name 
To sort comments by Author, click the Author title column 

Click the Author column 

heading to sort 

Comments will appear sorted by author 
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Applying Filters 
To apply filters to all columns, click the Filter button. Filter arrows will become enabled on each 

applicable column as shown below. 

Click Filter List for all column 

heading filters to become enabled 

Filter by date 

Filter by Author 

Filter by Status 
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Comparing documents in a Bluebeam Session 

When reviewing documents, comparing two versions of the same document in the Bluebeam 
session is possible by opening both documents and splitting the window in two. Documents in 
the Bluebeam session have the blue studio symbol (icon) on the left of the document name tab. 

To split the window and view both documents at the same time select the Window menu and 
click on “Split Vertical”. 

Click View 

Click Split Vertical 

Note: Reviewers can see the same place on both documents simultaneously using the Synchronize 
Document tool. 
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The split screen will display both documents as shown below. 
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Measure Tools 

The Measure tool creates measurements in any of several measurement modes. Measurements can 

persist as markups, allowing for processing and summarization through the Markups list, which 

is useful for estimation and takeoffs, or be temporary, which is useful for quickly measuring and 

adding up measurements without creating a visual record on the PDF. 

When the Measure Tool is activated, the last measurement mode used is automatically 

selected. This makes it easier to employ your most commonly used measurement mode. 

To enable accurate measurements, the user must first calibrate the page/drawing; then, 

proceed to use any of the measurement and calibrate tools available. 

Click Measure 

Click Tools 
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Calibrate 
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Review Closure and Responses 
Review period will end at 11PM on the date indicated. At that point, the Project Manager will 

close access to reviewers, and open access to designers. Designers typically have 10 days to 

respond. 

Designer completes response to comments, Project Manager will notify all reviewing sections. 

Comments will be output to PDF, organized by reviewing unit, with dynamic links to reference 

documents. 

Project Manager will schedule a Comment Resolution Meeting to resolve any questions. 

Comment Resolution 
Designer shall be responsible for ensuring comments are either addressed or that 

recommendations for next steps on unresolved issues be noted in follow-up memo. 
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Appendix A: Bluebeam Manual Consultant Evaluation Form Guidance 

Guidance for MassDOT Project Managers: 

- Consultant Evaluation Forms shall be uploaded into the Bluebeam Session by the MassDOT 

Project Manager at the 25%, 75% and 100% design stages, including any resubmissions. This 

form will become part of the design submission package. Design consultant performance 

evaluations are required per Engineering Directive E-10-005. 

- The 25%, 75% and 100% Consultant Evaluation Forms can be found in Section 810 – 
Contract Award Process, Attachment E in the Project Management SOPs. 

- Once located in the SOP, please save a copy of the Consultant Evaluation Form to a pdf 

using the following file naming structure: [009]-[Project File #]-[XX% Consultant Evaluation 

Form]. 

a) File naming example: “009-612190-100% Consultant Evaluation Form”. 

- After uploading the form into the Bluebeam session, the Project Manager is required to edit 

the applicable fields in red; see image below. The PM shall enter the Project file number and 

the Project description. The Bluebeam “Text Box” markup tool shall be used to input this 

information. 

- The PM is responsible for making sure that all applicable review sections have included a 

score by the review session due date. If a score is missing the PM is responsible for 

contacting the reviewer(s) for compliance. 

- The PM will enter “NA” in place of a score when review sections are not required to provide 

a score for a particular submission. For example, a Highway Project may not require a score 

from the HQ-Bridge Section. 

- When the Bluebeam session ends, the MassDOT PM will save the Consultant Evaluation 

Form in the applicable folder in ProjectInfo with the entire design submission package. 
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Guidance for MassDOT Reviewers: 

- At the 25%, 75% and 100% design stages, all applicable reviewers shall provide a score on 

the Consultant Evaluation Form, which will be located within the Bluebeam Session. Design 

consultant performance evaluations are required per Engineering Directive E-10-005. 

- When in the Bluebeam session, the reviewer can refer to the Consultant Evaluation Form for 

guidance on scoring a design submission. To locate the form within the review session, 

please note example of the file naming structure, “009-612190-75% Consultant Evaluation 

Form”. 
- The Bluebeam “Text Box” markup tool shall be used to input a score. Each review section 

will include their score in the applicable colored cell of the form; see image below. 

- Review sections that are not required to provide a score for a particular submission will 

enter “NA” in the required field. For example, a Safe Routes to School Project may not 

require a review by the Landscape Section. 

- The Consultant Evaluation Form will be stored with the design submission package and can 

be located in ProjectInfo for future reference. 
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Appendix B: 25% Stage Consultant Evaluation Form 
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Appendix C: 75% Stage Consultant Evaluation Form 
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Appendix D: 100% Stage Consultant Evaluation Form 
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Change Log 

- Version 3.0 – Official Release, October 2022 

- Version 3.1 – Revised Appendix, November 15, 2022 
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